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Part I - Overview 
Legal Library is as easy to use as Microsoft Word with a few customized Legal Library tools and 
options.  The major difference is that before beginning work on a document, you need to specify 
which type of document to work on from the File Menu on the toolbar. This guide will assist you 
in filling out a legal document for you Real Estate transactions.   
 
The CBA Legal Library 2005 supports 4 types of documents:                                     

 
1.)  New Custom Forms are interactive forms that you fill out on-screen. You 
can also edit the body of the text of the forms. If you make modifications to the 
body of the text, the document will show these changes as crossed-out letters (for 
deletions and/or small capital letters for insertions. 
New custom forms have the extension ".cbf"  
 
2.)  Saved Custom Forms are simply versions of the custom forms that you have 
modified and saved.  
Saved custom forms have the extension ".cbd"    
 
3.) Forms for Client Review Forms are special versions of Saved Custom 

Forms that custom forms that you can send to your clients for review and 
edit. These documents can be opened without the need to have the Legal 
Library installed on the user’s machine.  They can be edited by Legal Library 
Users or anyone that has the Client Review Document Editor.  This editor 
can be downloaded and installed at:  
http://legallibrary.commercialmls.com/downloads/DocumentEditor.msi 

Client review forms have the extension ".doc" 
 
4.)  Open Selected Standard Forms (Hard Copies) are forms with blank lines 
that you can print out and fill in by hand or with a typewriter.  
Standard forms have the extension ".cbp" 
 

We could also mention a fifth type of document, of which there is only one instance: 
CBAStartup.doc. This document acts as the gateway to the CBA Legal Library; opening this 
document is the only way to begin a session with the CBA Legal Library. 
 
Basic Operation 
Begin the CBA Legal Library 2005 by double-clicking on the icon that was copied to your 
desktop during installation. This Icon looks like a yellow legal pad with the title “Legal Library 
2005” on it. Alternatively, you can open MS Word and click on the Legal Library button in the 
tool bar. 
 
When the document loads you will see the CBA_LL toolbars and menus in place, and the CBA 
Logo on the one page of CBAStartup.Doc. Use the File/LL Form List command to bring up a 
list box with the 40+ custom ‘template’ forms that comprise the CBA Legal Library 2005. You 
can select a form, or multiple forms to edit by checking the box next to the form(s) you want, 
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then selecting ‘OK’ button. The form(s) are then opened and you can begin by selecting and edit 
mode.  Select ‘Fill-in’ mode to fill in empty fields. Use the tab key or mouse to move from field 
to field.   
 
If you wish to edit the actual text that makes up the body of the document, you can switch into 
Modify Text mode by selecting ‘Modify Body Text’ from the Edit Mode menu, or be selecting the 
Modify Text button on the Toolbar which has the image “ABC” on it. Then you can toggle back 
into Fill- in-Form mode by using the corresponding menu item or toolbar button. 

 
Part II – What’s New for Legal Library 2005 

Legal Library 2005 works just like Legal Library 4.0c does with a few new tools and some minor 
functionality changes.  Legal Library 4.0c was designed with minimal MS Word features 
available to it.  Legal Library 2005 is opened to MS Word entirely.  MS Word tools and editing 
functionality can be applied to Legal Library 2005 documents. 
 
A Few Enhancements 

 
1)  Legal Library 2005 can be used while MS Word and Outlook are running. 
2)  Fill in fields in a centralized location. 
3)  Email documents from within Legal Library 2005. 
4)  Clients can review and modify draft copies sent to them. 
5)  Save existing file with a new name. 
All of these enhancements are explained in the User Guide section of this documentation. 

 
A Few Changes 
  
New default location for saved documents. 

1) Three new saving methods. 
2) New file extensions for documents (.cbd and .doc) 
3) Release Notes 
4) Automatic upgrades and updates 
All of these changes are explained in the How To section of this documentation. 

 
Part III – How to 

There are two methods of accessing Legal Library 2005. Every time Legal Library 2005 opens 
the application automatically check the Legal Library Web Server for updates.  
 
Launching Legal Library 2005 

1) Double Click on the desktop icon, Legal Library 2005.   

2) Open MS Word and click on the Legal Library button from the tool bar.   
 
Release Notes 
Each time you launch Legal Library 2005 a Release Notes dialog box appears containing 
information for the user.  This dialog box can be disabled by checking the box “Do Not Show 
This Message Again” and clicking okay.  This box will reappear when the Release Notes have 
been updated with new information. 
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File Menu Items 
These items are located in the File Menu. 
 
Accessing New, Saved and Blank Forms 
There are three options for accessing forms. 
 

1) LL Forms List  
This command allows you to start with a new form template for editing.  When selecting 
this option a dialog box will appear with a list of all the available forms.  You can select 
one or more templates to work on by checking the box next to each form description.  
Each template will open in its own window. 
 

2) Open Saved LL Form  
This command allows you to open previously saved forms.  When selecting this option 
an Open File dialog box will appear.  By default, the Original Documents folder opens 
with all files you have previously created and saved. 
 

3) LL Forms List - Open Selected Standard Forms  
This command allows you to start with a new form template for editing.  When selecting 
this option a dialog box will appear with a list of all the available forms.  Change the 
selection below to “Open Selected Standard Forms” and then print the document out so it 
can be filled in by hand or with a typewriter. 

 
Saving Original Documents & Client Review Documents 
There are a few ways to save files in Legal Library 2005. 
 

1) Save Form  
This command allows you to save an Original Document (filename.cbd) to the Original 
Document Folder.  Save Form is specifically used for saving Original Documents.  By 
default, Original Documents are saved with the .cbd file extension in the Original 
Documents folder. 
 

2) Save As  
This command allows you to save and rename a previously saved Original Document 
with a new name (newfilename.cbd), creating a new Original Document.  Save As is 
specifically used for renaming and saving an original document with a different name, 
creating a new Original Document.  By default, Original Documents are saved with the 
.cbd file extension in the Original Documents folder. 
 

3) Page Setup / Line Numbering 
This command allows you to add line numbers to your documents.  From the File Menu 
select Page Setup, then select the Layout Tab, then select the Line Numbers button 
and then check the box Add Line Numbering.  Click OK twice and this will exit the 
Page Setup and add the line numbers to your document. 
 

4) Print 
This command allows you to print a document to your available printers.  When opening 
any Legal Library document for print, select the File Menu then the Print option.  This 
will open a print dialog box with all of your print options. 
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5) Send To 
You now have the ability to email a Client Review Document (filename.doc) form within 
the document.  After choosing Export for Client Review and saving the file with a file 
name, select File\Send To\Recipient as Attachment.  This will open a new email 
message in MS Outlook with the Client Review file (filename.doc) attached to it.  Simply 
fill in the recipients email address and press send.  

 
6) Close Form 

This command allows you to close the current form and prompts you to save the 
document. 
 

7) Exit 
This command will exit Legal Library 2005. 

 

Tool Bars Items   
These command icons are located in the tool bars. 
 
Editing Documents 
Documents will remain protected until you access one of the following edit modes. 
 

1) Fill in Fields    
Select this icon in the tool bar to fill in the blanks of the template.  Each time you access 
Fill in Fields mode for the first time a separate “Document Fields” dialog box will appear 
with a line by line list of the fill in fields for that document.  You can enter text in each 
line as described.  Once you finish filling in the fields, completely or not, click the Apply 
button and this will send all the text you entered to the appropriate field.  If you would 
rather fill in the template by scrolling through the document, click the cancel button and 
the “Document Fields” dialog will disappear for that Fill-in Fields session. 
 

2) Edit Document Text    
Select this icon in the tool bar to modify document text.  You can add and striking 
through text in this mode, plus import images, insert comments and highlight text for 
making certain areas of your document stand out.  When you select this icon, you will see 
an additional tool bar appear for this mode. 
 

3) Export for Client Review   
Select this icon to save a Client Review Document (filename.doc).  By default, Export for 
Client Review will always save a Client Review Document with a .doc file extension and 
will create the DRAFT watermark on the document.  By default, Client Review 
Documents are always saved in the Review Documents folder. 
 

4) Document Compare   
Select this icon to compare Original Documents (filename.cbd) against Client Review 
Documents (filename.doc).  Users can accept or reject the changes from the Client 
Review Document to the Original Document and then save it as the New Original 
Document.  This function is available while in an Original Document.  This function will 
open a File Open dialog box where you can choose the Client Review document.     
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Select the document to be compared and a new file will be opened with all the 
modifications made to the Client Review document appearing in blue.  You can accept or 
reject the changes by right clicking on each change made and the choosing accept or 
reject changes.  Once you are finished with the Document Compare, choose file save 
form and you will be prompted to save the file as an Original Document (filename.cbd).  
You can select an existing file name to save over, or you can give the document a new 
name at this point.  Note: Accepting the edits from the Client Review Document become 
permanent changes to the Original documents after saving. 
 

5) Keep Paragraphs Together   
This command formats the selected page boundaries without splitting paragraphs. 

 

6) Reject Changes   
This command will allow you to remove a strike though added to the document text.  
Simply highlight the section with the strike through and click this button to choose to 
reject the changes.  Or, right click on the highlight and select Reject Changes.  The text 
will now be back to its default state. 
 

Legal Library Tools 
 
Editing Client Review Documents 
Recipients now have the ability to review and edit the Client Review Documents (filename.doc). 
Existing LL 2005 Users can simply open the Client Review Document outside of Legal Library 
2005 and edit it by the Fill in Field and Edit Document Text tools available when opening a 
Client Review Document.  Recipients of a Client Review Document that do not have LL 2005 
can edit Client Review Documents by getting the Document Editor located at: 
http://legallibrary.commercialmls.com/downloads/DocumentEditor.msi 
Once they download and install the Document Editor they will be able to edit Client Review 
Documents anytime they receive one.  NOTE: The Document Editor only needs to be installed 
one time. 
 
Conversion Tool / Accessing Files from Version 4.0c 
If you have Legal Library 4.0c documents on your machine or on a network share folder you will 
need to convert thes documents for use in Legal Library 2005.  Launch the conversion tool by 
selecting: Start\Programs\CBA\Legal library\Conversion Tool.  Click Add File(s) then 
navigate out to the folder where the saved files you created in Legal Library version 4.0 are 
located.  NOTE:  By default, the files are located in C:\Program Files\Cba Legal Library 
4\SavedCustom folder.  If you have saved files to a different location, navigate to that location 
when prompted to do so.  Now select the files you want to convert and then click Convert.  You 
can select all files by highlighting one file and clicking Open.  A dialog box will appear asking if 
you want to add all documents in the directory.   
Select Yes to convert all the documents in the folder.   
Select No if you want to convert the files individually by holding down the Ctrl key on your 
keyboard and clicking on each file you want to convert.  Click Convert and the conversion 
process will begin and step through the file(s) you selected and convert them for use in Legal 
Library 2005.  A green light will appear next to the file to confirm a successful conversion.  The 
files are now converted and ready to use in Legal Library 2005.  The converted files will be 
located in the same directory you selected the 4.0c files from and it will create a Backup Folder in 
that same directory and backup the 4.0c files into it. 
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Automatic Updates 
Each time you launch Legal Library with an active Internet connection running, the application 
automatically checks the Legal Library Web Server for updates and downloads and installs any 
upgrades or updates if necessary.  If any updates or upgrades are received, Legal Library will 
inform you that the application has been updated and then ask you to close and restart Legal 
Library 2005.  This process is done immediately at launch and may cause the Legal Library 2005 
to load slower than normal if a download is available. 

 
Part VI – Forms Index 

 
AD_1 Disclosure of Agency or Non-Agency 
AR Arbitration Rider 
BB_1 Retainer Agreement 
BUA Back-Up Addendum to Purchase and Sale Agreement 
CB Co-Brokerage Agreement 
CDF Commission Disbursement Form 
DTR Deed of Trust Rider 
DW Waiver of Right to Receive Real Property Transfer Disclosure 
EMN Earnest Money Note 
GR-LS Gross Lease 
HMA Hazardous Materials Addendum 
LLR Limitation on Landlord's Liability Rider 
LN Claim of Lien 
LOI Letter of Intent 
LOR Guaranty of Tenant's Lease Obligations Rider 
LP_L Lead Based Paint Disclosure for Leases & Rentals 
LP_S Lead Based Paint Disclosure for Purchases & Sales 
LR Release of Listing 
MT_LS Multi-Tenant Lease Agreement 
N_1A Promissory Note - Fixed Rate of Interest 
OR Option to Extend Rider 
OTB Option to By Real Estate 
PI Commercial Property Information 
PR Parking Rider 
PS_1A Purchase & Sale Agreement 
PS_2 Bus. Op. Purchase & Sale Agreement 
PS_2A Bus. Op. Real Estate Addendum 
PSA Addendum/Amendment to P&S Agreement 
PS-AS Assignment & Assumption Agreement 
PSR Rescission of Purchase and Sale Agreement 
RC Recording Cover Sheet 
RL Release of Lien 
RPTD Real Property Transfer Disclosure Statement 
RR Rent Rider 
RUR Retail Use Rider 
ST_LS Single Tenant Lease Agreement 
Sub-Ls Sublease Agreement 
UA Utility Charges Addendum to P&S Agreement 
VLA Vacant Land Addendum 
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XA Exclusive Agency Listing Agreement 
XB Business Exclusive Sale Listing Agreement 
XL Exclusive Lease Listing Agreement 
XS Exclusive Sale Listing Agreement 
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